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Abstract 

Flood is one of the major issues which effects many people in different levels in 
Sudan. The decision makers need new techniques to support their decision before and 
during the flood. The Water Resources Planning and Management Project (WRPM) 
of NBI funded this research for capacity building in the field of DSS in 
Hydroinformatics at UNESCO-IHE. 
 
From July to September 2007, Sudan suffered from the most destructive flood, Sudan 
has faced in the last 20 years. Many cities and especially Khartoum (the capital of 
Sudan) suffer regularly from flooding.  The damage of flood in 2007 in Khartoum 
was more than 45 million US dollars.  
 
The Blue Nile contributes with around 68%, Sobat with 16% and White Nile and 
Bahar-El-jabal with 16% of the flow in the Main Nile after Khartoum. There is an 
urgent need nowadays for better understanding of flood generation.  Moreover, it is 
crucial to have a simulation model which can understand the relationship between the 
discharge at the border of Khartoum and its contribution to the flood, in order to save 
the life of the people and save animals and goods. 
 
The World Bank funded Delft Hydraulics to build a real time forecasting model after 
the devastating flood in 1988. The model started working in 1992. Unfortunately, 
nowadays the model -Flood Early Warning System (FEWS) - suffers from many 
problems, for example with respect to forecasting the time of the flooding.    
 
This research contains preparatory analyses for improvement of the flood forecasting 
model, and an analysis of the current and potential flooding problems in Khartoum. A 
water balance between Rossieres (500 km from Khartoum) and Sinnar (340 km from 
Khartoum) and between Sinnar and Khartoum has been made in order to know if the 
available data is sufficient and accurate to build a 1D hydro-dynamic model, to be 
used to predict the discharge and water levels at Khartoum during the flood season. 
From the results of the water balance between Rossieres and Sinnar dam, it can be 
concluded that the available data is of good quality and is probably sufficient to build 
a 1D hydrodynamic model. Water balance for the reach Sinnar and Khartoum showed 
best results. From the results of the water balance between Sinnar and Khartoum dam 
it can be found that the data is of good quality for building a 1D hydro-dynamic 
model.  
 
For flood analysis a 2D model which simulates the water level at Khartoum has been 
made. SOBEK 2D was used, to simulate the water depth at Khartoum. A flood extent 
map for Khartoum was made with GIS. A topographical map of Khartoum was used 
for better understanding of the flood extension and depth. A comparison between the 
free SRTM Digital Elevation Map and the elevation contour map has been made. The 
differences between the elevation map from a free source and the topographical 
elevation map were large. The elevation differences in some areas along the river 
bank are 17 meters. SRTM free source for DEM map is not recommended to be used 
for the extension of the flood in Khartoum. The result of the extent of the flood from 
SOBEK had been checked with free remote sensing images. The result of the flood 
extension from SOBEK compared with the remote sensing images was almost the 
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same in extent. Different scenarios were computed to simulate future expected flood 
due to climate change.  
 
Omdurman was almost unaffected from flood by climate change, and Bahri was more 
affected from flood due to climate change and Khartoum was highly affected by the 
climate change.  
 
The flood extent map will provide the decision makers with information of areas at 
risk by defining flood risk zones. Moreover, it will help spatial planning, and public 
awareness to be raised in the areas at risk of flooding. 
 
All the steps and sources of information have been put in a base data file for future 
research. 
 

 
 
 
 
 
 
 

 
 
 
 

Keywords: 
Simulation, flood, Blue Nile, Khartoum, SOBEK, 2D, GIS, Remote Sensing, flood 

extent, DEM, scenarios, Climate change 
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1 Introduction 

1.1 Introduction 

From July to September 2007, Sudan suffered from the most destructive flood the 
country has faced in the last 20 years. Many villages and towns in the whole country 
were inundated. The floods affected the lives of thousands of people and animals. The 
flood was accompanied by pollution of water and spread of insects that are a threat to 
the public health. Infectious diseases appeared in many places threatening the life of 
many inhabitants. Therefore, there is a need to mitigate the consequences of flooding, 
especially in the capital Khartoum. 

1.2 Background Information 

Sudan lies in tropical Africa (Figure  1.1). Its climate varies from equatorial in the 
south, savannah in the middle lands, and continental in the north and Mediterranean 
climate with winter rain in the east. The rainy season extends roughly from June to 
September. The annual rainfall is 1800 mm, though at Khartoum the capital it is only 
80 mm. Sudan is generally spreading a wide plain, with mountains in the north east, 
near the red sea coast and near the south east borders. The Nile is the dominant 
geographical feature of Sudan as around 70% of the area of the country is situated 
with in the Nile River catchment. Severe floods occurred in recent years in Khartoum: 
in 1999, 2000, 2001, 2006 and 2007. 
The Blue Nile drains a large area of the Ethiopian highlands and is the largest 
tributary of the Nile River, providing a vital source of fresh water to Sudan.  The Blue 
Nile contributes with around 68%, Sobat with 16% and White Nile and Bahar-El-
jabal with 16% of the flow in the Main Nile after Khartoum. 

1.3 Problem description  

The damage resulting from the 2007 flood in Khartoum State alone was estimated by 
more than 45 million US dollars (Ministry of Civil Defence, 2007). There is a great 
demand to reduce such losses in future flood situation. 
The current operational flood forecasting and early warning system -Flood Early 
Warning System (FEWS, Delft Hydraulics 1992) - suffers from many problems, for 
example with respect to forecasting the time of the flooding.  
In order to describe the problem of flooding in Sudan, and especially in the Blue Nile 
in Khartoum, we need to know damage statistics in Sudan and in Khartoum. There is 
no specific report about damages in Khartoum except in 2007. The records of some 
years are missing. Either the damages are small or the reporting is not done or the 
report is not saved and documented well. 
The people along the White Nile in Khartoum are the people who suffer regularly 
from flood (Figure  1.1). The Blue Nile during the rainy season in the upper catchment 
in Ethiopia brings with it a lot of sediments. The flow of the Blue Nile is higher than 
the flow of the White Nile. The White Nile brings little sediment.  During the wet 
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season, from July to September the high flow in the Blue Nile blocks the water from 
the White Nile, and the resulting back-water causes flooding of the White Nile banks.  
 

 
Figure  1.1: Sudan map 

 
Elduma, (2004) summarized the flood disasters in Sudan from 1965 to 2004 are as 
shown in Table  1.1. From Table  1.1, it follows that on average every 2 or 3 years 
there is a flood. 
 
Table  1.1: Flood disaster in Sudan and impact on people (Elduma, 2004) 

Events  No. of event  Killed  Injured  Affected 

Flood  17 383 18,556 6,614,962 

 
In his report also we can read that the majority of population is around the Blue Nile 
and White Nile. When the flood hit those highly populated areas, the damage become 
high. The population density in Sudan (inhab/km2) is shown in Figure  1.2. Figure1.3 
shows the inundated people and animals during the flood.  
 
This research is intended to contribute to better management of future floods in order 
to reduce flood damage and the number of people affected. 
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Figure  1.2: Population density in Sudan. 

 

 
 

 
Figure  1.3: Inundated area, affecting people, animals and goods 

1.4 Literature review 

1.4.1 Data reliability and availability 

Mekawi et al., (2005) in her research made discharge and water level validation from 
(1965-2000).  
She found that the availability of the data for the period 1965 to 2000 is estimated 
around 90%. In addition, the work shows that the greater part of the available data can 
be considered reliable, accurate and in agreement with other well known sources. This 
is, no doubt, promising for future work. However, the fact that the data of specific 
years at some of the gauging sites is uncertain should not be avoided. 
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1.4.2 Flood forecasting in the Blue Nile 

Conway, (1997) in a paper of a water balance model of the Upper Blue Nile in 
Ethiopia, showed that no published data existed for the whole of the Blue Nile in 
Ethiopia until the USBR carried out a major survey of the land and water resources of 
the Blue Nile basin between 1958 and 1963 (USBR, 1964a,b,c). More recently, 
Sutcliffe et al. (1989) and Dugdale et al. (1991) describe flood forecasting work on 
the Blue Nile using METEOSAT-derived rainfall estimates and a simple daily 
hydrological model. 
 
The World Bank has funded flood forecasting work on the Blue Nile undertaken by 
Delft Hydraulics, in association with the Soutanes Water Resources Department 
(Grimes et al, 1993; El Amin El Nur et al, 1993). An 11 region distributed model of 
the Blue Nile was developed, based on the Sacramento Watershed model (Grijsen et 
al, 1992). The name of this model is FEWS. Sudan Flood Early Warning System 
(FEWS) is in operation since August 1992, providing an advanced operational tool 
that gives three days a head the water levels and flows at El Deim, using remote 
sensing and hydrologic modelling techniques. However there is a new version of 
FEWS which is not yet available in Sudan. Moreover, the old version of FEWS which 
is used in Sudan encounters many problems nowadays like: 

• The bathymetric survey has been done in 1991 to support the development of 
the FEWS model. Two bathymetric surveys have been done after that and 
none of them included in FEWS model. 

• The capacity of Roseris Dam and Sinnar Dam were changed because of the 
great amount of sediment that comes from the upper catchment during the 
flood.  

• Dams’ operation rules were never updated to the model since the development 
of the model in 1991. 

• New dams were not included to the model. 

• The most important input after the development of the model is the satellite 
data of Tamsat. However, there is no any access to the Tamsat data nowadays. 
For the model just some images from private source have been used, which do 
not fit the model well. 

 
As a result there is need for a new model to predict the flood especially in Khartoum. 

1.4.3 Presentation of the flood and its effect 

Alphen, (2007) who works for the Dutch Ministry of Infrastructure and Water 
Resources, mentioned in a presentation about Risk Management Cycle and Flood 
Risk Mapping, different ways for presenting maps. For Example, he made maps 
combining growth of population and economy, potential flood extent, flood extent, 
depth of flooding, scenario’s for max. flood depth, flow velocities, scenario’s for 
progress and rate of rise, flood risk as combination of intensity (depth and or velocity) 
(or sensitivity) and probability, potential damage and casualties, flood risk map for 
insurance, risk of vital objects, social vulnerability, evacuation maps and evacuation 
routes.  
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Abdallah, (2005) mentioned in his report about Flood Risk Management that there are 
three components that determine flood risk, for example, flood hazard, vulnerability 
and exposure: 

• Hazard: the threatening natural event including its probability / magnitude of 
occurrence. 

• Vulnerability: the lack (or loose) of resistance to damaging/destructive forces. 

• Exposure: the values/humans that are present at the location involved. 
He mentions the development of flood risk management by the following elements: 
prevention, protection, preparedness, emergency response and recovery and lessons 
learned. 

1.4.4 Flood damages in Sudan 

SUTCLIFFE, (1989) this paper showed that it is important to note that two distinct 
events occurred in succession: an exceptionally intense storm over Khartoum, and 
heavy rainfall over Atbara basin (and to a lesser extent the Blue Nile basin) which 
gave rise to inundation in north Sudan. 
 
Humanitarian_Aid_Commission, (2007) showed that the most affected areas in 
Khartoum are: Sherg Al Nile, Jabl Awlia, Omdurman, Mayo, Al Hella Al Gadeida, 
Soba, Umdwanban, and Al Elafon. Moreover, they recommended Toti Island and 
residential areas around both Blue Nile and White Nile must take a preventive action 
to save lives and properties. 

1.4.5 SOBEK 1D/2D model 

Bashar, (2005) in his Msc. thesis did research on Floodplain Modelling in Bangladesh 
by SOBEK 1D/2D Coupling System. He mentioned Delft-FLS as a reliable model for 
simulation of the flood, which is now embedded into SOBEK as Overland Flow 
Module, is a two dimensional hydrodynamic simulation package based on fully 2D 
shallow water equations. Moreover, he mentioned the Coupling of 1D and 2D Model 
as an implicit coupling of 1D and 2D schematisations is based on the concept that 
both are defined on separate computational layers, similar to the concept of the 
storage of spatial data on different layers in a GIS. (Figure 1.4) shows the combined 
finite mass volume for 1D/2D computations. 
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Figure  1.4 combined finite mass volume for 1D/2D computations (source: adopted from Bashar, 

2005). 

 

Fei, (2004) in his Msc. thesis did research on Modelling Compound Channels with 
SOBEK, he mentioned both the 1D2D coupling model and the fully 2D model can 
reproduce the data following the trend of small scale laboratory data, and the model 
shows good fitting with laboratory data. Moreover, the boundary condition is the key 
issue during the model set up. Further more, he found for different Manning 
roughness coefficient of 2D grid, the model was not sensitive enough to represent the 
roughness changes. 
 
SOBEK is an integrated software package for river, urban or rural management. This 
program is very easy to understand it and quick to know it. It can download 
information from a variety of standard data formats and GIS systems. (Delft-
Hydraulics, 2006). 
The Overland Flow (2D) module of SOBEK-Rural is designed to calculate two-
dimensional flooding scenarios. The module is fully integrated with the 1DFLOW 
module for accurate flooding simulation. It is especially designed to simulate dam 
breaks and dike breaks. The hydrodynamic simulation engine underneath is based 
upon the complete Saint Venant Equations. It can simulate steep fronts, wetting and 
drying processes and sub critical and supercritical.  
The water flow is computed by solving the complete De Saint Venant equations. 
The flow in one dimension is described by two equations momentum equation and the 
continuity equation. (Delft-Hydraulics, 2006) 
 
Equations used for SOBEK 1D: 
 
The continuity equation reads: 

lat

f
q

x

Q

t

A
=

∂

∂
+

∂

∂
 

Where: 
Af = Wetted area 
qlat = Lateral discharge per unit length (m2/s). 
Q = discharge (m3/s). 
t = time (s). 
x = distance (m). 

The momentum equation is: 
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The first term describes the inertia. 
The second term describes the convection. 
The third term describes the water level gradient. 
The fourth term describes the bed friction. 
The fifth term describes the wind friction. 
 
Q= Discharge [m3/s]. 
t= Time [s]. 
x= Distance [m]. 
Af= Wetted area [m2]. 
G= Gravity acceleration [m/s2] (=9.81). 
h= Water level [m] (with respect to the reference level). 
C= Chézy coefficient [m½/s]. 
R= Hydraulic radius [m]. 
Wf= Flow width [m]. 
twi=  Wind shear stress [N/m2]. 
rw=  Water density [kg/m3]. (1000). 
 

Equations used in SOBEK 2D: 

 
The flow in two dimensions is described by three equations: the continuity equation, 
the momentum equation for the x-direction and the momentum equation for the y-
direction.  
 
The continuity equation  
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Momentum equations 2D flow 
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Where: 
u: velocity in x-direction(m/s) 
v: velocity in y-direction (m/s) 

V: velocity: 22
vuV +=  

ς : Water level above plane of reference (m) 

h: total water depth: ς +d(m) 

d: depth below plane of reference (m) 
C: Chezy coefficient (m/s)1/2 
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a: wall friction coefficient (1/m) 
 
The continuity equation ensures the conservation of fluid. They consist of acceleration 
terms, the horizontal pressure gradient terms, advective terms, bottom friction terms 
and wall friction terms. These equations are non-linear and they are a subset of the 
well-known shallow water equations that describe water motion for which vertical 
accelerations are small compared to horizontal accelerations (this applies to tidal flow, 
river flow, and flood flow). 

1.4.6 Climate change and its effect for future flooding in Khartoum 

Boko et al., (2007) in the IPCC report about Africa, they mentioned that Africa is one 
of the most vulnerable continents to climate change and climate variability. In 
addition, Rainfall is likely to increase in some parts of East Africa, according to some 
projections, resulting in various hydrological outcomes. (Fig1.5). 
 

 
Figure  1.5 possible future impacts and vulnerabilities associated with climate variability and 

climate change for Africa (Boko et al., 2007). 

 
Christensen et al., (2007) expected that there is likely to be an increase in annual 
mean rainfall in East Africa. It is unclear how rainfall in the Sahel, the Guinean Coast 
and the southern Sahara will evolve. 
 
Young, (2004) assessed how climate change will impact the engineering design of the 
Merowe dam. She mentioned that the evapotraspiration lead to precipitation, as a 
consequence lead to high flow of the Nile. From the extensive literature review, she 
found that, there is a wide disparity in predictions of future Nile flow scenarios. 
Strzepek et al., (1995) found changes in runoff from a hydrological model using GCM 
based climate change scenarios for doubled global atmospheric concentrations 
(2xCO2) provide widely diverging pictures of possible future Nile flows: GISS—a 
30% increase; UKMO—a 12% decrease; and GFDL—a 78% decrease. These are 
postulated for the year 2060. (Conway and Hulme 1996) suggests currently 
anticipated changes in atmospheric concentrations of CO2 by year 2025 would lead to 
air temperature increase of 1°C across Nile Basin, leading to increased evaporation 
loss and slight increase (2%) in rainfall in Blue Nile Basin and slightly larger increase 
(5%) over Equatorial Lakes region, spread fairly evenly through wet and dry seasons. 
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(Yates 1998a) found that Nile water resources declined under GFDL and increased for 
the GISSA and UKMO scenarios. (Yates 1998b) supports previous findings that 
changes in precipitation and to a lesser extent temperature over the Nile basin could 
have serious consequences on regional water resources throughout this large African 
basin. The 2xCO2 GCM scenarios gave a wide range of changes both in total water 
yield at Aswan and regional hydrologic changes throughout the basin. Five of six 
GCMs showed increased flows at Aswan, with increases as much as 137% (UKMO). 
Only one GCM (GFDLT) showed a decline in annual discharge at Aswan (-15%). 
Five of six GCMs predict increased precipitation in equatorial Africa. With some 
GCM scenarios predicting large increases in Nile discharge, there will be a need to 
increase flood protection, particularly in the Sudan.   
The author at the end estimated 6% of the Nile increase at Aswan Dam.  
 
Kim, (2007)expected that  in a 100-year time series analysis using the outcomes of the 
six general circulation models showed that precipitation changes for the 2050s (2040 
through 2069) can be -7% to 28% with a mean increase of about 11%. 
 
Yimer, (2008) who is a NBI student works in parallel research; he provided input for 
this research. He expected an increase inflow during the rainy period, in August he 
expected and increase of 15%.  
 
It can be concluded that here the majority of the models expected an increase in the 
Nile flow, but it’s difficult to determine an exact number of an increase. There is a 
high uncertainty about the climate change in the Blue Nile due to different model that 
had been used to predict the rainfall. So, different scenarios for climate change should 
be made. 

1.4.7 Water Balance in Blue Nile 

Abbas et al., 1999) in the research of Water Balance of Roseires | Sennar Reach, 
found that the annually water balance between Rossieres and Sinnar showed a good 
result. In addition, the abstraction project between Rossieres and Sinnar consumes 
around 6% from of the annual river flow, this percent in some creases up to 100% 
during the low flow of the river. Moreover, he calculated the catchment of the rainfall 
between Rossieres and Sinnar Dam, the catchment produces around 1.5% of the river 
flow, and it can be up to 10% to 15 % on daily basis.  
 
For the calculation of rainfall runoff for the catchment between Rossieres and Sinnar, 
five rain stations have been used for the calculation of the runoff. The reach has been 
divided to three sub-catchments as shown in Table  1.2. The runoff coefficient has 
been estimated for the three sub-catchments as shown in Table  1.3. 
 

Table  1.2: Sub--catchments between Rossieres and Sinnar. 

Sub-catchment North Middle South 

Area in Km2 2268 10205 2194 

Rain gauges Sinnar, Um Benen Um Benen, Abu 
Naama, Damazine 

Damazine, Bau 
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Table  1.3: Runoff coefficients. 

Catchment North Middle South 

April to June 0.08 0.1 0.12 

July 0.1 0.12 0.14 

August to Sep. 0.14 0.18 0.28 

Oct. to Dec 0.09 0.11 0.13 

 

1.5 Objectives         

  

1.5.1 Main objective 

The main objective is to analyse and simulate the flood in Khartoum for the Blue Nile 
in Sudan and prepare a GIS map for the expected flood areas in Khartoum, and to 
help decision makers to take mitigation measures. 

1.5.2 Detailed objectives  

The detailed objectives for this research are: 

• Literature review.  

• Data collection from Sudan.  

• Data collection from free web sites. 

• Data processing and validation of the data. 

• Flood analysis on the basis of the data. What are the causes of flooding? What 
is the role of local rainfall? What are the thresholds of discharge and water 
level in the Blue Nile at Khartoum at which flooding may occur? 

• Make water balance for the Blue Nile. 

• Preparation of detailed topographical elevation map for Khartoum city. 

• Comparison between the detailed topographical elevation map and the free 
source elevation map from SRTM website. 

• Preparation of 2D hydrodynamic model, which simulates the water level in the 
Blue Nile and White Nile. 

• Preparation of flood depth map and flood extent map in Khartoum. 

• Comparison of modelled flood extent in Khartoum with remote sensing 
images. 

• Generate different scenarios for expected climate change. 

• Document the steps of the work and the collected data and reports 
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1.6 Methodology 

The methodology which is followed in this research is: 

• A water balance along the Blue Nile will be made to check the data and the 
system. 

• A GIS tool will be used to create a detailed elevation topographical map for 
Khartoum by digitizing contour lines for Khartoum city and lower the river by 
using the historic cross sections of the rivers.  

• A free source site for DEM map will be used, and Arc Hydro Tools will be 
used to give the river its elevations. 

• The 2D model (SOBEK) will be built for Khartoum to simulate the water 
depth and the extent of flood in Khartoum. 

• The generated water depth in Khartoum from SOBEK software will be 
extracted as an ASCII file, and then GIS will be used to present the flood 
extent map and flood depth. 

• The result of flood extent from SOBEK and free sources of remote sensing 
image at the high period of flood will compared. 

• Different scenarios would be generated for expected flood due to climate 
change or due to any extreme event such as heavy rainfall in the upper 
catchment combined with heavy local rainfall. 

1.7 Tools 

In this research SOBEK will be used, because the new version of FEWS Sudan will 
use SOBEK. Moreover, it is a powerful instrument for flood simulation and flood 
forecasting, The GIS will be used because it is a good tool in presenting and 
overlaying different features. Arc Hydro Tools will be used to lower the river. Remote 
Sensing will be used because it shows the flood extent in different years before and 
after the flood.  
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2 Data  

In this chapter a description to stations will be made. Moreover, the collected data 
from Sudan and free sources will be described and analysed.  

2.1 Introduction 

Figure  2.1 shows the Blue Nile and its tributaries and the White Nile. Moreover, it 
shows the location of the stations and the location of the dams. Table  2.1 shows the 
longitude and latitude for different stations. 
 
 

 
Figure  2.1 Blue Nile map (from Nile DST software) 

 
Table  2.1 The longitude and latitude of the stations 

Station name Longitude Latitude 

Tamaniat 32.65 15.96667 

Khartoum 32.51667 15.6 

Jabal Awliya 32.5 15.21667 

Medani 33.51667 14.4 

Sinnar Dam 33.63333 13.55 

Gazira & Managil 33.63333 13.55 

Hawata 34.61667 13.4 

Giwasi 34.1 13.31667 

Rossieres Dam 34.38333 11.95 

Eddiem 34.98333 11.23333 
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2.2 Measurement stations 

            
Figure  2.2: Down scaling to the study area 

 

The Blue Nile system: 

The Blue Nile system consist from some measuring stations, two measuring 
tributaries and abstraction projects 
 
Eddiem Station: 

It’s located at the border of Ethiopia and Sudan. It’s very important station, because 
the operation of Sinnar and Rossieres depend on it. It measures the discharge to the 
Blue Nile at the border. It’s located at deep rock area which gives good records.  
 
Rossieres Dam Station: 
There is an upstream gauge reading, downstream gauge reading and discharge 
measurement. The discharge is the summation of the discharge from the deep sluices, 
spill way and hydropower station. The upstream gauge is reliable.  The downstream 
gauge is subjected to the turbulence of the flow, and it’s located on Rossieres bridge 
pillar, and there is a possibility of an error up to 30cm. Abbas et al, (1999). Figure  2.3 
shows Rossieres Dam during the data collection period.  
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Figure  2.3: Rossieres dam with the deep sluices and spell way closed (Zaroug, 2008) 

 
Sinnar Dam Station: 

There is an upstream gauge reading, downstream gauge reading and discharge 
measurement. The upstream and downstream gauges are considered reliable, because 
the downstream gauge is located at 1.4 km from the dam. Fig2.4 shows Sinnar Dam 
during the flood season. 
 

 
Figure  2.4: Sinnar Dam with opens gates during the flood season. 

 

 
Medani Station: 

For Medani station there is only gauge station, and there is no discharge measurement. 
An equation which describes the relation between the water level and discharge 
should be made in the future. 
 
Khartoum Station: 
There is a gauge station on the Blue Nile and there is also discharge measurement for 
the Blue Nile at Khartoum.  
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The main two tributaries to the Blue Nile are Dinder and Rahad 
Rahad Station: 
The station of River Rahad is located at El_Hawata. River Rahad is one of the main 
two tributaries to the Blue Nile. It joins the Blue Nile just downstream Medani. 
 
Dinder Station: 

The station of Dinder station is located at Gwasi. River Dinder is the second 
tributaries to the Blue Nile. It joins the Blue Nile upstream the junction with Rahad. 
 
Jabal Awliya Dam Station: 

There is an upstream reading, downstream reading and discharge measurement. It’s 
located in the White Nile River upstream Khartoum State.  
 
Tamaniat Station: 

Its located downstream Khartoum State, it’s an important station, because it gives the 
summation of the Blue Nile and White Nile during the low season.  

2.3 Collected data 

For the purpose of this research, a visit to Sudan has been made from 5th of 
November 2007 to 14th of December 2007. The data have been collected from 
different cities and ministries. Data were collected from: 

• Rossieres (more than 500 km from Khartoum) 

• Sinnar Dam (more than 350 km from Khartoum) 

• Hydraulics Research Station (HRS) in Medani (around 180 km from 
Khartoum) 

• Directorate of dams in MOIWR 

• Directorate of Water Resources in MOIWR 

• Remote Sensing Unit, Survey Department and Water Resources Department in 
Khartoum University.  

• Ministry of Metrology 

• Ministry of Civil Defence. 

• Ministry of Agriculture 

• Meirag Company and  

• Dar Consult. 

2.3.1  Discharge and water levels data: 

The discharge and water level were collected for Eddiem, Rossieres, Sinnar, Medani, 
Khartoum, Jabal Awliya and Tamaniat. The data was collected for the years 1999 to 
2007. The data are complete for the all stations, very few missing days in the data. 
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2.3.2 Rainfall data 

The rainfall data was collected for the important cities like Rossieres, Sinnar, Medani 
and Khartoum. Data in stations between these cities were not collected because of the 
price of data. The data was collected also for the years 1999 to 2007.  

2.3.3 Tributaries to the Blue Nile 

The discharge and water level for the main two tributaries Rahad and Dinder to the 
Blue Nile were collected for the years 1999 to 2007. Rahad and Dinder are seasonal 
rivers. They contribute with an influential amount of water. 

2.3.4 Cross sections of the Blue Nile 

The cross sections of the Blue Nile from Rossieres to Sinnar and from Sinnar to 
Khartoum were made in 1991 for the development of FEWS.  The intervals of the 
cross sections were not the same.  Other detailed cross sections were made for the 
centre of Khartoum for the Blue Nile, White Nile and Main Nile in 
UNESCO_Chair_for_Water, (2002). 

2.3.5 Abstraction Projects in the Blue Nile between Rosieres and Sinnar dam 

The abstraction projects in the Blue Nile were calculated and collected in order to 
enhance the water balance in the Blue Nile. Moreover, the abstracted amount of these 
projects is substantial. It is important to check the water balance in the system for 
future building of 1D SOBEK model and to estimate the discharge at Khartoum. 
 
The crop water requirement is calculated for these projects by determining first the 
total area for each project and each crop as shown in Error! Reference source not 

found. in the appendix, and then calculated the required water for each crop in a 
specific month as shown in Table 1 in the appendix. Finally multiply the total area for 
each crop and each project by the required water for each crop in a specific month as 
shown in the appendix in Table 2.  
 
Gazira and Managil projects are the biggest agricultural projects in Africa under one 
administration. The area of this project is around 2.5 million Fadden, the abstraction 
by Gezira and Managil project is also determined in Table 3. The required water is 
calculated as an average of ten days in each month. 

2.3.6 Damages of Flood 

Information and data about damages of the flood were collected for recent years from 
1998 to 2007, damages of the flood were collected for the Whole country, and 
especial consideration was made for Khartoum. More information and analysis is 
made in section  3.6 of this research. The collected data shows the death of people, 
casualties, death in animals, destroyed houses, destroyed trees.  For the year 2007 the 
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damage cost is calculated in Khartoum from the flood is more than 45 million US 
dollars. 

2.3.7 Free web sites  

Some free web sites were used for collecting some data such as:  

• This site allows to download the ASCII file for the selected region 
http://www.ambiotek.com/srtm 

• This following site shows how SRTM work. 
       http://www2.jpl.nasa.gov/srtm/SRTM_paper.pdf 

• The following site shows the Arc Hydro Tools. The Arc Hydro Tools set is a 
suite of tools which facilitate the creation, manipulation, and display of Arc 
Hydro features and objects within the ArcMap environment.  The tools 
provide raster, vector, and time series functionality, and many of them 
populate the attributes of Arc Hydro features.  The site contains the zip file of 
the Arc Hydro Tools setup file as well as several documents describing what 
the tools are and how to use them. 

      http://www.crwr.utexas.edu/gis/archydrobook/ArcHydroTools/Tools.htm 

• The following site shows how the Arc Hydro Tools working in the Java 
environment interface.       
http://www.ce.utexas.edu/prof/maidment/GISHYDRO/ferdi/research/agree/ag
ree.html 

• The following site contains the global flood archive as an animated image.  
You can visualize your concerned area.  

      http://www.dartmouth.edu/~floods/Archives/GlobalFloods1985-2007.gif 

• The following site shows an image of flood analysis with MODIS Terra & 
Aqua Imagery Recorded on 29 May and 2-4 September 2007. 
http://www.reliefweb.int/rw/fullMaps_Af.nsf/luFullMap/170F93434EDCD07
9852573530058FC51/$File/unosat_FL_sdn070910.pdf?OpenElement 

• The following site contains some remote sensing images before the flood and 
during the peak of the flood.   

       http://www-misr.jpl.nasa.gov/gallery/galhistory/2001_aug_29.html 

• The image of contour map of Khartoum in a Pdf format 
http://www.unsudanig.org/rco/data/flood/map/Map%201105%20Khartoum_P
otential_Flood_Zones_2007_v2.pdf  

2.3.8 Reports  

For the purpose of this research, many reports have been collected from different 
sources such as HRS library, General directorate of Dams, Rossieres Dam, Sinnar 
Dam, and Ministry of Civil Defence…etc. All these documents have been scanned 
and well documented in one folder. They will be free and available for anyone who 
wants to continue further more with this research or relevant work. 
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2.4 Preparation and validation of data 

The first stage was the preparation of the water level, discharge and rainfall data. The 
data was prepared in excel format for better understanding and interpreting of the data. 
For this purpose the macro tool in Microsoft Excel have been used to prepare the data 
in annual basis. When you record a macro, Excel stores information about each step 
you take as you perform a series of commands. You then run the macro to repeat, or 
"play back," the commands. The data was put also in a time series format. Short 
period of flood season was also made for better visualization to the flood season.  
The data have been subjected to a quick check for the odd data. There were some 
errors in the data due to human errors in the field or mistakes due to data entry. 
Sometimes, data is missing and in some cases numbers have been swapped (Figure 
 2.6).   
The data have been checked by comparing the hydrographs of a certain station with 
the downstream station and upstream station. Moreover, the data for the same station 
have been checked with the previous year and the next year. 
Many problems appeared at this stage, and sometimes data appeared to not even 
present what it was supposed to present. After careful checking and contacting the 
source to review the data, corrections have been made.  
There are some missing data in the duration of study period (1999-2007), and 
sometimes the missing data extends for more than two weeks (Figure  2.5). It’s 
recommended to fill those gaps by any good method. 

Sinnar daily discharge (2002)
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Figure  2.5 Missing discharge data from 20/7/2002 to 1/9/2002 
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Daily discharge at Tamaniat station (2001)
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Figure  2.6 Swapped number in daily discharge at Tamaniat station (81 to 18) 
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3 Flood analysis 

In this chapter the causes of the flood in Khartoum will be explained, the opinions of 
the experts will be discussed about the effect of local rainfall in Khartoum.  After that 
a rainfall analysis for Eddiem, Damazine (Rossieres), Sinnar and Khartoum will be 
made. Then, a runoff between Rossieres and Sinnar will be calculated from the 
available two rainfall stations. After that a discharge analysis will be made. Finally, 
the damages of the flood will be calculated. 

3.1 Causes of Flood 

One of the causes of the floods in Khartoum is an increase of water level above the 
bank of the river channel, after prolonged precipitation over large areas of a basin 
which, can also exceed the conveyance capacity of river channel, hence leading to 
flooding. Normally, river flood last for several days to several weeks and usually 
affects large areas. 
The threshold water level, which is determined by the FEWS model, is 16.5m; Figure 
 3.10 shows the threshold water level in Khartoum.  The generation of flood in 
Khartoum occur due to high rainfall in the upper catchment in Ethiopia. 

3.2 Effect of local rainfall  

The effect of local rainfall will be discussed in the following section. Opinions of 
experts are highly recommended to be considered. 

3.2.1 Opinions of specialists about the effect of the local rainfall 

In the travelling to data collection in Sudan, relative reports and literature reviews 
have been made about the effect of the local rainfall in Khartoum.  But unfortunately 
there were no reports about this important event. So information was gathered from 
the opinion of the experts on this field as explained below: 
 
Dr. Jamal Mortada from Khartoum University thinks that from his point of view the 
damages of the flood in Khartoum are due to lack of proper drainage system. 
Moreover, the rainfall occurs 6 to 7 times during the flood season with the little 
amount of rain in Khartoum, and the effect of the rainfall is neglected. 
 
Dr. Said Drman who works in the Ministry of Metrology, said the effect of the local 
rainfall is, when the people near the affected areas and the government are working to 
make temporary barriers (filling sand bags), and the rainfall comes, it slows or 
prevent the people to finish the work. Another problem he said, the rainfall water 
can’t reach the River. He said the main cause for the flood in Khartoum is due to the 
rainfall in the upper catchment Ethiopia. 
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Dr. Abdalla Khiar, who works in the Ministry of Metrology, said there is a great 
effect of the local rainfall, he said just a 10km * 10 km areas will contribute so much 
to the runoff, He said the water which comes to Khartoum is not only the water that 
comes from the upper catchment Etiopia and the main two tributaries Rahad and 
Dinder, but from the rainfall also along the Blue Nile in Sudan. Another Example he 
gave, is a dam in the north of Khartoum at the Main Nile, they built a dam for water 
harvesting and the capacity of that dam is 5 Mm3, and after one rainfall the whole dam 
was filled. 
 
Experts claim however that also local rainfall cases flooding in Khartoum. In 1988 a 
high water level accompanied by 210 mm rainfall in one day. 
 
From the above discussion we conclude that: 

• The opinions about the effect of local rainfall are contradicting. 

• Lack of proper drainage system causes a lot of damages. 

• The rainfall amount at Khartoum is low compared with upstream cities along 
the Blue Nile. 

• Rain fall itself slows or prevent the work of people who building temporary 
barriers. 

• Temporary barriers prevent the water to drain to the river. 

• A water harvesting dam at the Main Nile in northern of Khartoum shows great 
amount storage (5Mm3) after one rainfall. 

3.3 Rainfall analysis 

Rainfall has a great effect in social and economical life. Scarcity in rainfall leads to 
drought while an excessive rain in a short period of time leads to floods. In 1984, the 
year of the drought in Sudan, Khartoum received only 4.7 mm of rain between May 
and October.  A famine hit Sudan as a consequence of crop failure, and people 
migrated to search for food and water. In 1990 there was also little rainfall (4mm). 
 
Floods reflect the other extreme in rainfall fluctuations. It occurs when a rainfall 
during a short period of time, is well above average. We must look to many factors in 
order to determine the severity of the flood, such as the slope of the land, the soil type 
and the amount of water in the soil. In the 4th of August 1988, Khartoum was hit by 
216 mm of rainfall during a period of 24 hours. This situation became disastrous 
when the Nile rose around 7m above normal, which led to wide spread damages in 
properties of people in Khartoum.  
 
A rainfall analysis to the stations along the Blue Nile will be made below. Special 
consideration will made to the months which expect damages due to local rainfall.  
Moreover we will look how the rainfall varies from the upstream stations to the 
downstream stations.  Any average monthly rainfall less than 20 mm/month will not 
be considered in the analysis of the water balance. 
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Rianfall in Damazine (Rossieres) from 2003 to 2007
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Figure  3.1: Rainfall in Damazine from (2003 to 2007). 

 

Monthly average of Damazine (Rossieres) rainfall from 1999 to 20007
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Figure  3.2: Monthly average of damazine (Rossieres) rainfall from 1999 to 2007. 

 

Damazine station is located at 11.81 latitude line and 34.39 longitude line. In 
Damazine station which is beside Rossieres, the rainfall occurs normally from May 
and October, and the highest rainfall occurs from July to September. (Figure  3.1). 
For the average monthly rainfall from 1999 to 2007 we found that from Figure  3.2, 
the rain decreases gradually from July (260 mm/month) to September (140 
mm/month). In addition, we infer that the highest contribution to the flow in the Blue 
Nile occurs in July. Moreover, the sudden increase of rainfall from June to July may 
cause high damage to Rossieres city due to local rainfall.  There is a rainfall station at 
the same sub catchment which called Bau. It’s recommended to be used in future 
analysis. 
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Rianfall in Sinnar from 2003 to 2007
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Figure  3.3: Rainfall in Sinnar from (2003 to 2007). 
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Figure  3.4: Monthly average of Sinnar rainfall from 1999 to 2007. 

 

 
Sinnar station is located at 13.54 latitude line and 33.63 longitude line. In Sinnar 
station also the rainfall normally extends from June to October, and the highest 
rainfall extends from July to September. (Figure  3.3). The rainfall during July and 
August in 2007 was high compare to previous years. For the average monthly rainfall 
from 1999 to 2007 we found that from Figure  3.4 the rainfalls in July and August are 
near to each other and around 180 mm/month. In September there is a sudden drop in 
the amount of rain to around 90 mm/month. In addition, the contribution of Sinnar 
sub-catchment to the river flow will be a lot during July and August. The damage due 
to local rainfall in Sinnar city is expected to be in July and August. There is a rainfall 
station at the same sub catchment which called Umm Benen. It’s recommended to be 
used in future analysis. 
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Rianfall in Medani from 2003 to 2007
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Figure  3.5: Rainfall in Medani from (2003 to 2007). 
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Figure  3.6: Monthly average of Medani rainfall from 1999 to 2007. 

 
In Medani station the rainfall extent from June and September.  There is little rainfall 
in October compare with other months at the same station and compare with upstream 
stations. The rainy season extend from July to September. (Figure  3.5). For the 
average monthly rainfall from 1999 to 2007 we found that from Figure  3.6 the 
rainfalls in July and August are almost the same and around 120 mm/month. But, 
unlike the upstream stations, the average monthly rainfall in August is a little higher 
than July. The contribution to the Blue Nile flow is high during July and August. The 
damage due to local rainfall in Medani is expected to be in July and August. 
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Rianfall in Khartoum from 2003 to 2007
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Figure  3.7: Rainfall in Khartoum from (2003 to 2007). 
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Figure  3.8: Monthly average of Khartoum rainfall from 1999 to 2007. 

 
In general the rainfall in Khartoum is much less than the other three upstream stations. 
From Figure  3.7 we noticed that the rainfall occurs between July and September. In 
August 2007, 6 consecutive rainfall events occurred in 20 days. That means the 
average period between rainfall events is around three days, which means the soil was 
saturated an another rain event came, which will lead to more overland flow and more 
discharge to the river. From Figure  3.8 we found that the rain in August (72 
mm/month) is much more than July and September (around 29 mm/moth). Khartoum 
is one of the highest populated cities in Sudan. Although the average monthly rainfall 
is not high like the upstream stations, but it could cause a lot of damages due to local 
rainfall. It’s clear that the local rainfall may cause damages during August.  The worst 
scenarios may occur at this month. 
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Rainfall and discharge in Khartoum from (1999 to 2007)
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Figure  3.9:  Rainfall and discharge in Khartoum from (1999 to 2007). 

 

 
From Figure  3.9 we notice that there is a relation between the peak of flow and the 
highest rain during the flood season in many years, and the peak of the rainfall is a 
little earlier than the peak of the flood. 

3.4 The threshold of the flood at Khartoum 

It is very important to know the threshold of the flood in Khartoum.  
 

Khartoum gauge from 1999 to 2007
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Figure  3.10: Khartoum time series of gauge reading with the threshold of the flood. 
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Figure  3.10 shows the threshold of the flood which is determined in FEWS model in 
Sudan. It is obvious that there is river flood in 1999, 2000, 2001, 2006 and 2007. 
From the trend of the time series in Figure  3.10 for the years 2006 and 2007 the flood 
was high compared with the previous floods.  
 
In Current FEWS which is used in Sudan, the limit for warning by the water level at 
Khartoum is as shown in Table  3.1. 
 

Table  3.1: Warning for flood in Khartoum by existing FEWS 

Warning Alert 

(m) 

Critical 

(m) 

Flooding 

(m) 

Water level 15 16 16.5 

 

3.5 Rainfall runoff between Sinnar and Rossieres 

The catchment between Sinnar and Rossieres in the Blue Nile contribute with a 
considerable amount of flow to the Blue Nile. During the flood season (July to 
September) the average monthly rainfall at July decreases from 260 mm/ month in 
Rossieres to 185 mm/month in Sinnar, at August from 210 mm/ month in Rossieres to 
175 mm/month in Sinnar, and at September from 136 mm/ month in Rossieres to 90 
mm/ month in Sinnar. 
The relation between the rainfall and runoff is complicated and subjected to many 
factors. Some assumptions will be taken in this calculation. The catchment was 
represented only by two stations because of the cost of data. The catchment was 
divided to three sub-catchments. The northern catchment represented by Sinnar 
station and the southern catchment represented by Rossieres station.  The middle 
catchment divided between the two stations. Each catchment got its own runoff 
coefficient as shown in the literature review in section  1.4.7. The rainfall consider to 
be effective when it’s more than 20 mm/day Abbas et al, (1999).  
The flow from the catchment has been calculated by using the rational method. 
 
The Rational equation is the simplest method to determine peak discharge from 
drainage basin runoff. It is not a sophisticated method (Chow et al., 1988). 
Rational Equation: 

                             CIAQ =  

The Rational equation requires the following units: 
Q = Peak discharge, m3/day. 
C = Rational method runoff coefficient. 
I = Rainfall intensity, m/day. 
A = Drainage area, m2. 

The assumption for the areal average rainfall within the sub-catchments depends on 
the location of the rainfall stations. Table  3.2 explains these assumptions. 
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Table  3.2: Aereal coverage assumption for the rainfall distribution. 

Sub-catchment Rainfall distribution 

North Sinnar 

Middle Sinnar/2 + Damazine/2 

South Damazine 

 
The calculated flow will be used in water balance in chapter 4. 

3.5.1 Discharge analysis 

Eddeim discharge from 1999 to 2007
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Figure  3.11: Eddeim discharge from 1999 to 2007 

 

Rosieres discharge from 1999 to 2007
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Figure  3.12: Rossieres discharge from 1999 to 2007 
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Sinnar discharge from 1999 to 2007
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Figure  3.13: Sinnar discharge from 1999 to 2007 

 

 

Khartoum discharge from 1999 to 2007
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Figure  3.14: Khartoum discharge from 1999 to 2007 
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Khartoum gauge station vs accumilated rainfall in Khartoum (July to September-2000)
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Figure  3.15: Accumulated rainfalls and water levels at Khartoum from July to September 2000. 

 

Khartoum gauge station vs accumalated rainfall in Khartoum (July to September-2007)
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Figure  3.16: Accumulated rainfalls and water levels at Khartoum from July to September 2007. 

 
From Figure  3.11 , the discharge time series for Eddiem station from 1999 to 2007 
shows that for the year 2007 we can notice that the discharge is low compared to 1999, 
2000, 2001 and 2006. Similarly, in Figure  3.12, the discharge time series for 
Rossieres station is also low for the year 2007 compared with the other flood years at 
the same station. If we move downstream to Sinnar station as shown in Figure  3.13, 
we found that also in the discharge time series for the year 2007 is also low compared 
with the other flooded years. However, for Khartoum time series, the discharge for the 
year 2007 is high as shown in Figure  3.14, and almost the same as in 2006 and even 
higher than in 1999, 2000 and 2001. We can infer from that, there is an effect of local 
rainfall which causes the discharge to increase rapidly at Khartoum station. 
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In addition, if we look at Figure  3.10, we found that in both 2000 and 2007 there was 
a flood. However, from Figure  3.15 for the accumulated rainfalls and water levels at 
Khartoum from July to September 2000, we found that the flood is from the river only 
because the rainfall was very little. On the other hand from Figure  3.16  for the 
accumulated rainfalls and water levels at Khartoum from July to September 2007, the 
flood is from the river and accompanied by the local rainfall. It can be seen that in 
2000 the flood is not accompanied by local rainfall, whereas in 2007 it accompanied 
by about 120 mm. this explain why the damages are high in 2007. The coming section 
will show in details about the damages of the flood in Sudan, and in more details the 
damages of the flood in 2007. 

3.6 Damages of flood 

From the Ministry of Civil Defence, which consists from soldiers, who responsible for 
natural disasters in Sudan. There are some statistics that show the damages of the 
flood in Sudan for different years. From Table  3.3 to Table  3.10 we found that the 
damage of the flood affects different sectors and different levels. However, the 
condition of the flood for 2002 is alert from Table  3.1. For the year 2003 the river is 
almost flooding. The following tables will show the damages of the flood in Sudan.  
 
Table  3.3 Damage of building due to flood. 

Years Affected 
states 

Affected 
provinces 

Affected 
villages and 
cities 

Affected 
families 

Affected 
individuals 

1999 17 40 562 292429 1452152 

2000 9 22 57 7850 89974 

2001 16 35 340 21217 120025 

2002 13 20 163 2817 304961 

2003 12 25 1148 34194 125175 

Total 67 142 2270 358507 2092287 

 
Table  3.3 above shows the effect of the flood from a big scale to small scale. It shows 
the effect for the years from 1999 to 2003. Recent years are not included on this table. 
The minimum damage occurred in the year 2000 because it’s a river flood only, and it 
was not accompanied by local rainfall. The highest damage occurs in the year 1999. 
 

Table  3.4 Injuries and died people directly from flood in Sudan (1998-2006) 

Years Injuries Death Total 

1999 76 125 201 

2000 13 53 66 

2001 0 4 4 

2002 9 37 46 

2003 217 35 252 

2006 20 38 58 

Total 363 347 710 

  
Table  3.4 shows the injured and died people in Sudan from flood from 1999 to 2006. 
The effected people in 2004 and 2005 either small or no one effected. The highest 
death also occurs in 1999. 
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Table  3.5 Number of casualties and number of people with health problems as a consequence of 

floods 

Years Sick Death Total 

1999 70560 299 70859 

2000 99353 320 99673 

2001 1412 2 1414 

2002 201 28 229 

2003 217 35 252 

Total 199544 704 200248 

 
Flood may bring many diseases and water-borne diseases. Contaminated drinking 
water by floodwater may carry a lot of micro-organisms which can produce diarrhea, 
hepatitis, typhoid, tetanus…etc.  The flood can be even more dangerous when it nock 
people down or causes people to drawn, especially children. Table3.4 shows the death 
and illness due to flood from 1998 to 2003. 
 
Table  3.6: Number of public places and services affected by floods 

Years Social Water and 
Electricity 

Education Health Others 

1999 272 76 438 304 195 

2000 5034 21 66 91 182 

2001 13 34 6 7 132 

2002 3 0 86 17 1642 

2003  317 728 123 1427 

Total 5514 498 2149 636 3959 

 
The public places and services also affected by flood as shown in Table  3.6.  We see 
that the flood affected the public places which serve the whole community, and this 
damage reflects in the entire society. 
 

Table  3.7: Houses completely effected and partially effected by flood 

Years Partially Completely Total 

1999 43753 73291 177044 

2000 6985 873 7848 

2001 8978 9390 18368 

2002 5950 2950 8900 

2003 27180 12705 39885 

Total 116730 119209 235939 

 
As a result of flood, some houses are completely destroyed while other houses are 
partially destroyed. Table  3.7 shows the affected buildings by flood. The government 
has limited source, the effected people suffer a lot when they loose their own shelter. 
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Table  3.8: Agricultural losses due to flood (number of destroyed plants and trees) 

Years Palm and small trees Fruits 

1999 0 6300 

2000 0 305 

2001 40000 12500 

2002 11223 0 

2003 17000 646 

Total 1304331217 142351 

 
The agricultural sector in Sudan was affected by the flood. Table  3.8 shows the 
number of trees that died because of the flood.  In some years we see that the damage 
is zero. 
 
Table  3.9:  Animals died due to flood 

Years Sheep chickens 

1999 8547 5220 

2000 8750 12545 

2001 250 0 

2002 4527 0 

2003 3845 11416640 

Total 36815 11567076 

 
Table  3.9 shows the dead sheep and chickens due to flood. 
 
From Table  3.3) to table to  Table  3.10) we learned that the flood causes a lot of 
damages almost every year, with different level of damages. It’s important to know 
that the damage from  Table  3.3) to  Table  3.9) in the whole country and it’s not only 
in Khartoum state. The flood of 1999 causes a lot of damages because it’s also a river 
flood accompanied by local rainfall in Khartoum. However, the case in other cities 
could be different. It is clear that from the above tables that the flood affect all sectors 
of society and hit many areas in Sudan. Moreover, we can infer that, flood is a serious 
and frequent problem which repeated almost every two years. 
From the report of 2007  Table  3.10), we noticed from the below table that 19 people 
died in Khartoum, and the cost of damage is high, the losses cost in Khartoum only 
more than forty five million US dollars (Table 3.9). So if we manage to install a good 
warning system and clean the drainage system we could save a lot of money. From  
Table  3.10) we can see that there are other states which suffered and destroyed even 
more than Khartoum. The highest damage cost was recorded in 2007 was in White 
Nile state, the damage cost was more than ninety eight million US dollars, and the 
collapsed houses were high. South Kordufan state also need more attention, the 
damage cost was more sixty two million US dollars. The collapsed number of houses 
was also high. The damage cost in North Kurdufan was not high, but the death at this 
year was high, 36 people died. We can see also that the damage at Khartoum is 
relatively high compare with other state, given that it is small state compared to other 
state. The main reason for the high cost of damage, because it is highly populated. 
The damage in the agricultural sector at Khartoum is very low because there are little 
activities of agriculture. The highest number of affected individuals was recorded in 
White Nile state, 168155 people.  Then, South Kurdufan, 157625 people were 
affected. After that, 95915 people were affected in North Kurdufan. The fourth 
affected individuals were in Khartoum 76780. 
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Table  3.10 Damages in 2007 

Collapsed 
houses 

Casualties Trees and animals Roads and 
bridges 

No State 

whole partially death injuries Trees Animals Roads bridges 

General 
public 
places 

families Individuals  Cost in 
pounds 

Cost in 
dollars 

1 Kasala 1766 3295 15 0 1243 2430 1 1 4 5061 25305 46370450 23185225 

2 West Darfur 570 2846 4 0 187 250 1 - 24 3416 17080 3250000 1625000 

3 Red Sea 149 666 2 57 - 358 0 1 - 815 4075 855010 427505 

4 South 
Darfur 

388 1014 7 2 199 138 0 0 24 1402 7010 210829 105414 

5 Algazera 4461 3017 8 13 193000 1261 0 0 706 7478 37390 51076390 25538195 

6 Unity 5847 - 0 0 220000 - 0 0 - 5847 29235 31147000 15573500 

7 Upper Nile 2785 4645 0 0 - - 0 0 - 7430 37150 7430000 3715000 

8 South 
Kurdofan 

17816 14009 19 15 341568 3098  2 122 31825 157625 124223496 62111748 

9 North 
Kurdufan 

8352 10831 36 75 110730 13336 2 - 333 19183 95915 14920570 7460285 

10 Khartoum 6807 8499 19 19 4 0   36 15356 76780 90356000 45178000 

11 Alshamaliya 404 2127 4 4 53 0 1 1 40 2531 12655 7874345 3937172 

12 Blue Nile 2018 3489 4 6 116000 928 0 0 117 5507 27535 20015000 10007500 

13 Nile River 987 1076 2 2 2089 1400 1 0 69 2063 10315 19158010 9579005 

14 White Nile 14917 18714 21 70 6500 949 2  88 33631 168155 197010900 98505450 

15 Gadarif 3318 924 7 32 20000 0 2 1 3 4242 21210 13765000 6882500 

16 Sinar 5831 4594 8 6 0 157 1 1 97 4161 20805 12161000 6080500 

17 North 
Darfur 

181 526 1 1 0 0   85 707 3535 707000 353500 

18 Gongoli 0 2031 0 0 0 0 0 0 0 2031 10155 1015500 507750 

19 Lakes 0 242 0 0 0 0 0 0 0 242 1210 121000 60500 

20 Warab 0 250 0 0 0 0 0 0 0 250 1250 125000 62500 

Total 76597 82795 157 302 1011573 24305 11 7 1748 153178 764390 641792500 320896250 
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4 Water Balance 

4.1 Introduction 

In this research a water balance between Eddiem and Rossieres, Rossieres and Sinnar, 
and Sinnar and Khartoum. The main reason for this water balance, if it shows good 
result, probably it will be sufficient to build a 1D hydro-dynamic model in the future, 
upgrade of the flood early warning system, and for preparing models for the Nile DSS 
development. It may be possible also to predict the discharge at Khartoum from the 
discharge at Eddiem. If the water balance shows a good result that means during the 
flood season we can use the discharge at Eddiem, operation rule of the dams, 
abstraction projects, discharge of main tributaries, and estimation of the rainfall to 
predict the discharge at Khartoum.  

4.2 Water balance between Eddeim and Rossieres  

The reach between Eddeim and Rossieres doesn’t need a water balance. Because, the 
discharge at both stations is almost the same. There is a little flow contribution from 
small streams in the rainy season. Moreover, there is evaporation from Rossieres Lake. 
Finally the change in storage at Rossieres dam due to operation rule should be 
considered.   

4.3 Water balance between Rossieres and Sinnar 

Qcomp_R – AbsGM – Absproject– Evap = QBal_S 
 
Qcomp_R: Roseires Dam release 
AbsGM: Abstraction for Gezeraa and Managil Scheme. 
Absproject ; Abstraction by Wad Hashim, El Safa, El Nayra, Kassab, El Busata, Wad 
Reif, Karkoj, El Suki, NW Sennar and others projects. 
Qcomp_S: Sinnar Dam release. 
Evap: Evaporation losses from Sinnar reservoir 
QBal_S: Sinnar Dam release computed by the water balance.  
 
The percentages of the above variables during the peak of the flood are around: 
Qcomp_R = 100%, AbsGM= 3%, Absprojec = 1.5%, Evap. = 0.3 and QBal_S= 95% 
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Figure  4.1: Sinnar estimated against Khartoum discharge from water balances (1999-2007). 

 

 Appendix C: Water balance 

 
Table 4) in the appendix shows the water balance between Sinnar and Rossieres dam 
from 1999 to 2007. 
For this water balance the abstraction for Gezera and Mangil Scheme was calculated 
for the summation of 10 days, so for daily water balance it is divided by 10 in order to 
get it per day. 
For the abstraction projects between Sinnar and Roseris Dam it was calculated in 
monthly basis, so it was divided per month. 
The rainfall runoff was calculated as shown in section  3.5 . For better water balance 
the lag time between Roseires and Sinnar should be considered, and it varied in flood 
season and low season. Moreover, the last survey for Sinnar Lake was in 1984. The 
designed capacity of Sinnar was more than 900 Mm3, but now it losses more than two 
third of its capacity by the sediment, and there is no rating curve which can show the 
content with the gauge. 
 
Water balance for the reach between Rosseries and Sinnar Dam gave good results, but 
there is a little over estimation on the estimated discharge from the water balance. 
This is expected to come from the rainfall and the change in storage at the filling 
period of the dam. From the results of the water balance between Rossieres and 
Sinnar dam it can be concluded that the data is of good quality and is probably 
sufficient to build a 1D hydro-dynamic model. In addition, it may be possible to 
estimate the discharge at Sinnar by a water balance between Khartoum and Sinnar. 
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4.4 Water balance between Sinnar and Khartoum 

KhrtDRScomp QQQQ =++_  

Qcomp_S: Sinnar Dam release. 
QR: contribution of Rahad tributary . 
QD: contribution of Dinder tributary.   
QKhrt: Discharge at Khartoum. 
The percentages of the above variables during the peak of the flood are around: 
QKhr= 100%,  Qcomp_S= 92%,  QR= 2% and QD=6%. 
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Figure  4.2 Khartoum estimated against Khartoum discharge from water balances (1999-2007) 

 
Water balance for the reach Sinnar and Khartoum showed better results. The small 
differences of the two graphs are expected to be the effect of rainfall and abstraction 
projects. From the results of the water balance between Sinnar and Khartoum dam it 
can be concluded that the data is of good quality and is probably sufficient to build a 
1D hydro-dynamic model in the future , upgrade of the flood early warning system, 
and for preparing models for the Nile DSS development. In addition, it may be 
possible to estimate the discharge at Khartoum by a water balance between Sinnar and 
Khartoum, it can give indication to the flood with a cross check with model 
predictions. 

4.5 Problems for future development of 1D model 

For future 1D model development for the Blue Nile, the following points should be 
considered: 

• The distance between Eddiem station and Khartoum station is long (around 
600 km), and the running time may take a long time. 
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•  It needs a lot of cross sections to describe the long reach. There are only cross 
sections describing the reach between Eddiem and Rossieres Dam at the 
reservoir lake. In addition, the cross sections between Rossieres and Khartoum 
were made in 1991 and no any update for them since that time. Moreover, the 
intervals between the cross sections are not equal, and for some cross sections 
the interval is more than 5 kilometres.  

• The content of Sinnar Dam is not known up to now, and there is no relation 
between the water level and the content of the reservoir lake is not known.  

• The operation of Rossieres Dam and Sinnar Dam changes frequently due to 
the discharge from Eddiem, which need a special code for it. 
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5 Building the 2D model 

5.1 GIS analysis 

A GIS can be defined as a collection of computer hardware, software, and geographic 
data for capturing, managing, analyzing, and displaying all forms of geographically 
referenced information. (http://www.gis.com/whatisgis/index.html). 
 
Arc-GIS 9.2 is used in this research to georeference the free SRTM map and clipping 
for the desired area. More over it has been used to create shape files for the Nile River, 
crating counter maps to Khartoum, lowering the DEM of the river and converting the 
maps from one feature to another features. 

5.1.1 Downloading SRTM map 

The CGIAR-CSI GeoPortal is able to provide SRTM 90m Digital Elevation Data for 
the entire world. The SRTM digital elevation data, produced by NASA originally, is a 
major breakthrough in digital mapping of the world, and provides a major advance in 
the accessibility of high quality elevation data for large portions of the tropics and 
other areas of the developing world. The SRTM digital elevation data provided on this 
site has been processed to fill data voids and to facilitate its ease of use by a wide 
group of potential users. This data is provided in an effort to promote the use of 
geospatial science and applications for sustainable development and resource 
conservation in the developing world. Digital elevation models (DEM) for the entire 
globe, covering all of the countries of the world, are available for download on this 
site. The SRTM 90m DEM's have a resolution of 90m at the equator, and are provided 
in mosaiced 5 deg x 5 deg tiles for easy download and use. All are produced from a 
seamless dataset to allow easy mosaicing. These are available in both ArcInfo ASCII 
and GeoTiff format to facilitate their ease of use in a variety of image processing and 
GIS applications. Data can be downloaded using a browser or accessed directly from 
the ftp site. (http://srtm.csi.cgiar.org/).  
 
The NASA Shuttle Radar Topographic Mission (SRTM) has provided digital 
elevation data (DEMs) for over 80% of the globe. This data is currently distributed 
free of charge by USGS and is available for download from the National Map 
Seamless Data Distribution System, or the USGS ftp site. The SRTM data is available 
as 3 arc second (approx. 90m resolution) DEMs. A 1 arc second data product was also 
produced, but is not available for all countries. The vertical error of the DEM's is 
reported to be less than 16m. The data currently being distributed by NASA/USGS 
(finished product) contains "no-data" holes where water or heavy shadow prevented 
the quantification of elevation. These are generally small holes, which nevertheless 
render the data less useful, especially in fields of hydrological modelling. 
(http://srtm.csi.cgiar.org/). 
 
The SRTM radars were unable to sense the surface beneath vegetation canopies and 
so produced elevation measurements from near the top of the canopies. Man-made 
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objects, such as large buildings, roads, towers, and bridges are often problematic 
targets for radar imaging. Reflections, shadows, and smooth surfaces in built-up areas 
can often lead to severe layover, shadowing, and multi path artifacts. Given the 30-90 
m posting of the SRTM data, only the largest man-made features are resolved, but the 
height of any urban SRTM pixel will be affected by the buildings within that pixel. 
Thus, heights measured in cities will represent average building sizes, rather than the 
height of the ground on which the buildings sit. Farr and Kobrick, (2005) 
 
Steps to download the SRTM map: Alfonso, (2007) 
 

• Download Google earth. 

• Open the following link with Google Earth environment 
http://www.ambiotek.com/srtm  

• Fly to Khartoum and click on “data for strm_43_09” as shown in figure5:1 

• The actual data can be accessed from servers at Kings College London, UK or 
at the CGIAR CGNET in California. The nearest one should be selected, for 
this case UK server should be selected. 

• Click on any FTP site as shown in figure5.1 to download a zipped ASCII file 
(be aware that the size of the zipped file could be up to 60MB). 

 
 

        
Figure  5.1 Download SRTM map of Khartoum 

5.1.2 Preparation of SRTM map in GIS environment 

Steps of preparing a DTM maps for the SOBEK by using GIS tool: 

• First we open a folder of STRM; inside this folder is the required map. 

• In this step we want to change our map from ASCII to Raster in order to clip 
our map as follow: Open ARC MAP > Conversion Tools > To Raster > ASCII 
to Raster > SRTM. 

• Put the curser in the map to determine the corner of the map 

• Data management Tools – Raster > Clip. 

• Then we made a geo-referenced to our map as follows:  
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� Data Management Tools > Projection and Transformations > Define 
Projection > Clip Raster > Select > Geographic coordinate System > World > 
WGS 1984.prj > Apply > Ok. 

� Data Management Tools- Projection and Transformation > Raster > Project 
Raster > Clip > Select > Projected Coordinate Systems > UTM _ WGS1984 _ 
32N > Apply > Ok. 

• The next step is to allow SOBEK to read the ASCII file: first Conversion 
Tools> Raster to ASCII 

 

−

0 10 20 30 405
Kilometers Elevation

High : 596

Low : 347          

−

0 1 2 3 40.5
Kilometers Elevation

High : 408

Low : 367  
Figure  5.2: SRTM for the study area. (http://www.ambiotek.com/srtm). 

 

5.1.3 The Arc Hydro Toolset 

5.1.3.1 Introduction to Arc Hydro Tools 

The Arc Hydro tools are a set of utilities developed on top of the Arc Hydro data 
model.  The Arc Hydro Toolset is a suite of tools which facilitate the creation, 
manipulation, and display of Arc Hydro features and objects within the ArcGIS 
environment.  Some of the functions require the Spatial Analyst extension.  The tools 
are accessed through the Arc Hydro Tools toolbar, where they are grouped by 
functionality into five menus and six buttons. .  The tools provide raster, vector, and 
time series functionality, and many of them populate the attributes of Arc Hydro 
features. ESRI, (2002c). 

5.1.3.2 Steps to include Arc Hydro Tools in Arc map environment 

ESRI, (2002b) 

• Run the setup (setup.exe) 

• Open ArcMap and load Arc Hydro tools  

• Open ArcMap.  Create a new empty map, and save it as ArcHydro.mxd (or 
any other name). 

• Right click on the menu bar to pop up the context menu showing available 
tools. As shown in Figure  5.3. 
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                      Figure  5.3 Active Arc Hydro Tools 

 

• The Arc Hydro Tools toolbar is shown in    Figure  5.4    . 
 

 
Figure  5.4 The Arc Hydro Tools toolbar 

 

• Load the clipped SRTM map data 

• Click on the  icon to add raster data.  

• In the dialog box, navigate to the location of the data, select the raster file (e.g. 
“DEM”) and click on the “Add” button. 

• The added file is listed in the Arc Map Table of contents. 

• Select Terrain Preprocessing | DEM Reconditioning. As shown in    Figure 
 5.5    . 

 

 
         Figure  5.5 DEM Reconditioning 
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• Select the appropriate DEM and linear feature.  The output is a reconditioned 
Agree DEM (default name AgreeDEM), as shown in    Figure  5.6    . 

 

 
                                               Figure  5.6 DEM Reconditioning (Agree) 

5.1.3.3 Terrain Preprocessing  

Tools in this menu deal with processing of Digital Elevation Model (DEM). It uses 
DEM to identify the surface drainage pattern. They are mostly used once in order to 
prepare spatial information for later use. All the steps in the Terrain Preprocessing 
menu should be performed in sequential order, from top to bottom 

5.1.3.4 DEM Reconditioning (AGREE) 

   ESRI, (2002d) the DEM Reconditioning function (Terrain Preprocessing menu) 
modifies Digital Elevation Models (DEM) by imposing linear features onto them.  It 
is an implementation of the AGREE method developed at the University of Texas at 
Austin in 1997.  For a full reference to the procedure refer to the web link 
http://www.ce.utexas.edu/prof/maidment/GISHYDRO/ferdi/research/agree/agree.html  
 

• The function needs as input a raw DEM and a linear feature class (river) that 
both have to be present in the map document.   

• Names of DEM must be known in advance. 

• The user needs to select an existing grid theme name that will be tagged with 
the "Raw DEM" tag at the end of the operation. 

• Names of feature classes must be known in advance. Each feature class should 
have a unique name. 

• The user needs to select an existing linear feature class that will be tagged with 
the "Agree Stream" tag at the end of the operation. 

• The user needs to specify a grid name that will be tagged with the "Agree 
DEM" tag at the end of the operation.  If the specified output grid already 
exists, the user is prompted whether to remove the existing dataset. If the user 
doesn’t give a new name a default name will be used (Agree DEM). The user 
must be careful to use the new name DEM in the next process of embedding a 
new feature class. Make sure that the grids being created have unique names    
ESRI, 2002a) 

 
After initiating the function, the user needs to enter three reconditioning parameters: 

1. Vector buffer (cells) – this is the number of cells around the linear feature 
class for which the smoothing will occur.    Figure  5.7    . 

2. Smooth drop/raise – this is the amount (in vertical units) that the river will be 
dropped (if the number is positive) or the fence extruded (if the number is 
negative).  This value will be used to interpolate DEM into the buffered area 
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(between the boundary of the buffer and the dropped/raised vector feature). 
(Figure  5.7). 

3. Sharp drop/raise – this is the additional amount (in vertical units) that the river 
will be dropped (if the number is positive) or the fence extruded (if the number 
is negative).  This has the effect of additional burning/fencing on top of the 
smooth buffer interpolation.  It needs to be performed to ensure preserving the 
linear features used for burning/fencing.(Figure  5.7) 

 

 
Figure  5.7 Define Agree parameters 

 
The values used for the AGREE parameters depend on the nature of the DEM and the 
issues that are being resolved.  In many cases, a trial and error approach is needed 
before satisfactory results are obtained 

5.1.3.5 Creation of a shape file  

A shape file had been created in order to lower the cells correspond to those cells. 

• Data Management Tools  > Feature Class > Create Feature Class > (In the 
output location create a folder , In out put feature class give a name, In 
Geometry type select POLYLINE.  

• Editing > Start editing > (select the folder of the shape file) > Target select the 
name of the shape file > (Draw the shape file) as shown in Error! Reference 

source not found.. 
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Figure  5.8: Creation of different shape files. 

 

The result of the lowering grid will be as shown in Error! Reference source not 

found.. 
 
 

 

−
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Figure  5.9: Lowering the DEM corresponding to the shape files by Arc Hydro Tools. 



B uilding the 2D  m odelB uilding the 2D  m odelB uilding the 2D  m odelB uilding the 2D  m odel     

                                                              46 

 

5.1.4 Preparation of topographical map: 

For the purpose of this work and for good representation of the flood in Khartoum 
city a tedious work have been done to create a topographical elevation map for 
Khartoum. A PDF file from a free source was used to create an elevation map. 
http://www.unsudanig.org/rco/data/flood/map/Map%201105%20Khartoum_Potential
_Flood_Zones_2007_v2.pdf  
A PDF file of Khartoum with a high resolution was downloaded from the above site. 
The image contains contour lines at the city. In addition, it shows the location of the 
street with the red lines. However the map doesn’t show the elevation of the streets. 
Moreover, the map doesn’t show the contour lines at the White Nile, Blue Nile and 
Main Nile. The production agency of this map is UN MIS Unit, the map produced at 
May 2007. The GPS Data, Roads, Airstrips, Hydrology and Infrastructure were made 
by UNMIS. Not all contents of this map have been field verified. In the future it’s 
recommend that to verified this map with ground survey and GPS. 
The picture in Figure  5.10 showed the topographical map.  
 

 

 
Figure  5.10 Image of topographical map 
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5.1.4.1 Add and georeference the map 

• Download the PDF map from the free source site 

• Save the image as a TIF file in order to import it GIS environment. 

• Add the map  

• Then georefrenced the map as follow:  
� View> Toolbars> Georeferencing 
� Georeferencing> Fit to display> (from Google Earth select at least 

three points) > Click in the goerefereced point then to ungeoreferenced 
point>Press View link table (adjust the point to the desired one). 

� You have to be sure in the tag Layer the georeferenced layer is there 
 

5.1.4.2 Create shape files for the digitized contour lines 

• View> Toolbars> Editor 

• Create a shape files as mentioned above with the desired name (Contour 
Lines). 

• Open the attribute table> Option> Add filed> Give a name (Elevation) and 
select in the tag Type, short integer. 

• Editor> start Editing> select the location of the shape file> sketch tool> 
(magnify the original map to digitize the contour well). 

• Press Enter after digitize the whole contour (the contour should be digitized in 
one time)> in the attribute table in column Elevation (give the desired height)> 
Press save Edits. 

• Continue with the other contour lines. 
67 counter lines were carefully digitized as shown below in Error! Reference source 

not found.. 
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Figure  5.11: Digitized contour lines of Khartoum. 

 

                       

5.1.4.3 Convert the shape file to Tin 

Triangular Irregular Networks (TIN) has been used by the GIS environment to 
represent surface morphology. TINs are a form of vector based digital geographic 
data and are constructed by triangulating a set of points. The points are connected 
with a series of edges to form a network of triangles. There are different methods of 
interpolation to form these triangles, such as Delaunay triangulation or distance 
ordering. ArcGIS supports the Delaunay triangulation method.  (ESRI, 2006) 
The resulting triangulation satisfies the Delaunay triangle criterion, which ensures that 
no vertex lies within the interior of any of the circum circles of the triangles in the 
network. If the Delaunay criterion is satisfied everywhere on the TIN, the minimum 
interior angle of all triangles is maximized. The result is that long, thin triangles are 
avoided as much as possible. (ESRI, 2006) 
The edges of TINs form contiguous, non overlapping triangular facets and can be 
used to capture the position of linear features that play an important role in a surface, 
such as ridgelines or stream courses. Figure  5.12 shows the nodes and edges of a TIN 
(left) and the nodes, edges, and faces of a TIN (right).(ESRI, 2006) 
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Figure  5.12: Nodes and edges of TIN on left, surface of TIN  on right. 

 

Because nodes can be placed irregularly over a surface, TINs can have a higher 
resolution in areas where a surface is highly variable or where more detail is desired 
and a lower resolution in areas that are less variable.  
The input features used to create a TIN remain in the same position as the nodes or 
edges in the TIN. This allows a TIN to preserve all the precision of the input data 
while simultaneously modelling the values between known points. You can include 
precisely located features on a surface—such as mountain peaks, roads, and 
streams—by using them as input features to the TIN nodes. 
The steps to convert the shape file to TIN are: 

• View> Toolbars> 3D Analyst 

• 3D Analyst> Create/ Modify TIN> Create TIN from Features> in tag Layers 
(tick Contour Lines)> in Height source in Setting for selected layer (select 
elevation. 

• In Output TIN (select the location and the name of the file), the default name 
is tin. 

The created TIN is as shown in Error! Reference source not found. 
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Figure  5.13: Convert the shape to TIN. 

 

5.1.4.4 Create shape files for the digitized cross sections 

At this stage we need to create a shape file for the cross sections of the rivers, and 
give it the exact elevation to embedded on the TIN map of Khartoum. The first step is 
to import and georeference a map which shows the location of the cross section from 
a report (UNESCO_Chair_for_Water, 2002) as shown in Figure  5.14.  
The map shows intensive field and bathymetric survey work carried out by Hydraulics 
research station in May 2002 for UNESCO Chair in Water Resources for the project 
“River Nile Development within Khartoum Centre”. Twenty cross sections were 
surveyed bathymetrically and by land levelling. Moreover, thirteen auxiliary cross 
sections were bathymetrically surveyed; Figure  5.15 shows an example of an auxiliary 
cross section.  
Figure  5.16 showed the overlying of the scanned map over the image of the 
topographical map 
The next step is to create a shape file for the cross sections as follow: 

• Create a shape files as mentioned above with the desired name (Cross 
sections). 

• Open the attribute table> Option> Add filed> Give a name (Elevation) and 
select in the tag Type, short integer. 

• Editor> start Editing> select the location of the shape file> sketch tool> 
(magnify the original map to digitize the cross sections; in this step you need a 
ruler to put the points at the same place). 


